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Reparable GFP Item Processing with MIL-Comply  

GFP versus New Acquisition Items 
Shipping Government Furnished Property (GFP) that has undergone maintenance, repair or overhaul (MRO) requires 

the use of a Reparable Receiving Report (RRR) instead of the standard Receiving Report (RR).   [Ref DFARS Appendix F-

104(b)] 

Use of the special Reparable Receiving Report (RRR) is especially important for shipping Unique Identifier (UID)-

marked GFP items.  This is because: 

1. The Unique Item Identifier (UII) is already in the UID Registry, and a standard Receiving Report would result in 

an attempt to register it again 

2. The UID Registry requires the original date and cost of acquisition rather than the date and cost of servicing 

the item. 

Use of the RRR for MRO of non-UID GFP items is also required.   This is because these lifecycle costs are distinct from 

the cost of acquisition.  For MIL-Comply users creating these RRRs is just a matter of designating items as GFP and 

supplying a couple of additional location codes.  See RRRs for Non-UID GFP for more information. 

The Defense Federal Aquisition Regulations (DFARS) Appendix F regulate the use of the standard and Reparable 
Receiving Report transactions: 

F-10.  The WAWF RRR is the electronic equivalent of the DD Form 250 for repair, maintenance, or overhaul of 
Government-furnished property.  

F-104(b)  WAWF RRR or DD Form 250. Use as in paragraph (a) of this section for delivery of services for 

repair, overhaul, or maintenance. 

GFP Processing Methods 
There are three distinct methods of GFP processing in MIL-Comply which result in submission of a Reparable 

Receiving Report to Wide Area Workflow (WAWF). 

• GFP Processing with UID Registry Automation 

• Manual UID Registry Transactioning 

• Reparable Non-UID Items 

GFP Processing with UID Registry Automation 

1. Take Custody from UID Registry 

Use Comply/UID-Manager to: 

• Induct Received Item(s) into GFP Inventory  

• Acknowledge custody to UID Registry 
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• Confirm UID Registry custody change 

2. Prepare for Shipment 

With Comply/Pack-2073: 

• Package per Mil-Std-2073, or the contract-stipulated method 

With Comply/Labeling: 

• Label per Mil-Std-129 

o Select UID Items from GFP Inventory 

o Include RFID-tagging where required 

3. Submit Reparable Receiving Report to WAWF 

With Comply/Shipper: 

• Create Reparable Receiving Report (RRR) 

o Select UID items marked Ready-To-Ship from GFP Inventory 

o Include RFID data 

Reparable Receiving Reports without UID Registry Automation 
Companies with lower volumes of GFP items may find it more cost effective to handle the UID Registry transactions 

online in the UID Registry while still using Comply/Shipper to submit the Reparable Receiving Report to WAWF.  See 

Reparable Receiving Reports with Manual Custody Transfer. 

Reparable Receiving Reports for Non-UID Items 
DFARS Appendix F-104(b)  requires use of the WAWF RRR for delivery of services for repair, overhaul, or 

maintenance.  See RRRs for Non-UID GFP for instructions on preparing RRRs for those items. 
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UID Registry Automation 
MIL-Comply/UID Manager exchanges electronic transactions with the UID Manager to acknowledge custody of UID-

marked GFP items.  In some cases it needs to add items to the Registry or perfect their UIDReg records. 

Receiving GFP Item for Repair 

The first step in shipping repaired items is officially accepting custody of them from the Government.   This is done 

with a Direct (UID) Registry transaction that updates the status of each item.   Start by using Comply/UID-Manager to 

receive these items into your GFP Inventory. 

Before you can receive GFP items, you must identify the 

contract number to which they are to be associated.  If your 

database already has the contract simply [Open] it, 

otherwise, create one with [New Contract]. 

 

Complete the information in the dialog shown below in 

order to define a GFP contract.  The Order number is optional, but all other fields are required.  The ACO and PCO 

codes may be completed after receiving items, but are required for the WAWF Receiving Report. 

 

There are several contract types defined by the UID 

Registry.  The DOD FAR Contract is the most typical. 

 

 

 
 

GFP Contract Dashboard 
Once a contract/order has been opened, the UID 

Manager will present a GFP Dashboard, showing 

the operations that you can perform with GFP that 

involve interaction with the UID Registry.  The next 

thing to do is click on the [Receive New GFP Items] 

button. 
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GFP Receiver Screen 

 

 

A GFP Receiver is a collection of 

items that have been received at 

the same time.   Comply/UID-

Manager assigns an arbitrary ID to 

it, but you can use your own, such 

as a transportation tracking 

number.     The date of receipt is also recorded.   

Clicking on [Add New Items] brings up the Receive New Items dialog into which you can enter (paste) the UIIs or serial 

numbers of the items received.  A part number and description is required.  You may click on the [Parts Database] to 

pull down an already defined part.   This is the same database used by Shipper and Labeling.  

 

You may use [Add New Items] repeatedly to enter 

more GFPs or items with different part numbers 

and nomenclature.   

Items that are already in your GFP inventory 

(database table) will be marked with an asterisk 

and ignored when the Receiver is saved. 

Use the [Edit] button to make any corrections need 

to be made.   

Once all items for this Receiver have been entered, 

click [Ok] to save it. 
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GFP Items List 

The GFP Items Information dialog 

displays the items associated with 

the open contract/order.  In some 

situations, it may show only those 

items associated with a specific 

shipment and CLIN.    

The Editor is shown here after 

receiving the items described in 

the section above.   

Once GFP is received you must 

send a Change of Custody request 

to the UID Registry, acknowledging 

that the items are now in your 

company's possession, under the 

proper contract/order numbers. 

There are a number of buttons to 

set the status of GFP items.   Use [Acknowledge Custody] to 

identify those items that you wish to confirm the receipt of to the 

UID Registry.  Doing this changes their Registry Status to 

Acknowledge Custody (AckCust).  The next UID Registry transaction 

will include all such items.  Click [Ok] to save the changes to the 

item status.  

 

Upon returning to the GFP Dashboard, the items marked AckCust are reflected in the number shown next to the 

[Accept Custody] button.   Click on it to create a UID Registry transaction and send it to the UID Registry via WAWF.  

(See Sending Transactions to WAWF and UID Registry section for more information.) 
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Responses from the UID Registry 
The UID Registry (UReg) responds to electronic transactions by returning an XML file to the sender for each 

transaction file submitted.   The Mil-Pac VAN will also generate an email to registered parties when processing these 

response files.  After receiving the email, the UReg results may be downloaded and applied to the GFP items.    

Retrieve UIDReg results by clicking on the Registry Results main menu command.  If prompted to do so, Connect to 

the Mil-Pac VAN and retrieve waiting files.   Should you have previously downloaded response files that have yet to be 

processed you may skip the download process.   

For each Registry Response file, you will see a message like this one.   Hopefully all updates will be accepted, in which 

case, the status of each item will change to Property in Possession of Contractor (PPC).  Such items can then be 

transferred back to the government by including 

them on Reparables Receiving Report (RRR).   In 

this case, two of the item updates were rejected 

as were three of the items that were intended to 

be added to the Registry. 

    

As Registry Response files are processed its items will be listed on the Contract Dashboard view, as shown below.  You 

can double-click on each of the item, which will list their errors and allow you to fix them. 

 

 

 

 

 

Double-clicking on an item will show 

the full text of long or multiple error messages.  It 

will also allow the item to be modified and 

resubmitted.  To do so, just click [Ok] in response to 

the “Edit the item” prompt.   Responding to error 

messages will be explained in more detail. 
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After making a change to an item during the Registry Responses review process the item status will change to reflect 

the change.  You may correct as many or as few as would like, and then click [Send UID Reg Requests] to submit them.    

To finish correcting errors later, open the Contract, and select [View/Edit GFP Items].   Then select an item.   If the 

error message is Multiple Errors, click on the error message to see the full text of it, or additional errors if there are 

more than one.  Making corrections to the item will change its status to Acknowledge Custody (AckCust) so that you 

may submit it when ready.  



 

16 November 2018  Page:  9 
 

MIL -C O M P L Y  – Tech Note 

P r o c e s s i n g  G F P  R e p a r a b l e s  

Common Registry Response Errors 
There are a few errors which occur somewhat frequently when servicing items that require UID registration.   

UID Not Found in Registry     

There are several reasons that this might occur, but that is beyond the scope of this document.  Suffice it to say that a 

GFP item must exist in the Registry before one can take custody of it.  Fortunately, the process of adding items to the 

Registry is very easy in UID Manager. 

Note that the actual error message from the Registry is “Invalid entry - Uid was not found in the database or this XML 

file”.   In this context, it means that you tried to take custody of a non-existent item.   To fix this problem, enter the 

acquisition cost of the item as shown below in the GFP Item record.  

 

This will add the GFP item to the UID Registry, then take custody of it.   Determining the acquisition cost of an item 

may be a challenge.   Consult your contracting officer if it was not an item originally sold by your company. 

UID Value Already Exists in the IUID Registry 

This is the opposite of the Item Not Found in Registry error, caused by including the Acquisition Cost in the GFP Item 

record. This triggers UID Manager to attempt to add the item before taking custody, resulting in the error.   

Special Tooling or Test Equipment Status is Required 

The requirement to designate UID items as Special Tooling or Special Test Equipment (ST/STE) came about sometime 

after a large number of items were already placed into the UID Registry by the defense community.  To correct that 

problem the Registry requires designation of ST/STE status the first time the UIDReg records such items are updated.   

That results in the error message above. 

To respond to the error simply check the Update ST/STE Status option on the GFP Item Record editor. 

 

Then, select the appropriate designation, which will generally be Not ST/STE.   
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Managing GFP Across Contracts 
It is often useful to view and manage all GFP items, without regard to the contract they are associated with.  The View 

menu offers access to items without regard to their contract association.   View > All GFP Items command will show 

the same view one gets from the Contract 

Dashboard, but for all items in the database.   

The other commands allow the user to drill 

down more specifically.    

For example, View > Registry Errors shows all 

items that failed during custody updates and 

need attention.   

 

In most of the non-contract views you may change the filter to view by whatever status you choose, or simply view all 

items. 
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Labeling Items for Shipping 
Labeling GFP items in accordance with Mil-Std-129 is little different in 

MIL-Comply than labeling new acquisition UID items.  The difference 

is that new UIDs are added to the shipment as it is labeled, or as a 

part of a new Shipper Receiving Report.   Because GFP items were 

previously loaded into the database in order to send Change of 

Custody to the UID Registry, you simply need to select the item(s) to 

be labeled for shipment. 

Create a new shipment in Comply/Labeling (Advanced Mode).   Add a 

CLIN, and check the GFP and 

UID boxes.   Then [View] to 

see GFP items that are 

available for shipment. 

Items which have been 

confirmed by the UID Registry 

to exist and be in your 

company's custody are shown 

as PPC (Property in 

Possession of Contractor).  

PPC items may be shipped, 

along with those that are 

marked as OkToShip (more 

about those later).  Select the 

item(s) to ship and click [Ship 

to Govt].  The status of these items will change to Shipping, as shown in the example.   Note that the items have been 

assigned to the shipment number and CLIN that is currently being labeled.  More items can be added in the same 

manner.   Clicking on [Ok] returns to Labeling, which updates the UID Count and Total CLIN Qty fields.   The item's Part 

Number has also been populated from the GFP data. 

Clicking on [Part Number] will retrieve the item's NSN, Noun, etc from the Parts Database.   At this point you simply 

need to click on the Preservation [Date] and create labels as you would for shipping new acquisition items.   This 

includes RFID labels, which are handled in the normal manner. 
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Creating the Reparable Receiving Report 
When submitting a Receiving Report (RR) to WAWF for acceptance of repairs on GFP the Reparable Receiving Report 

(RRR) must be used instead of the standard one.   This is because the standard RR sends UIIs to the UID Registry for 

initial registration, and the cost of the line item is recorded as the acquisition cost of the marked items.  GFP should 

already be registered.   The RRR also changes custody of the GFP item(s) from the contractor to the Government or 

another contract.   

Creating an RRR shipment in Comply/Shipper is simple if the containers have already labeled in Comply/Labeling, 

which populates much of the data necessary for creation of the RRR.   The following example is the line item data in 

Shipper for the GFP labeled in the previous section: 

 

All that is left to be done is enter the price for the repair, add a couple of address DODAACs, then click on Submit to 

WAWF.   Click on [Edit UIDs] to see the items that have been selected for shipment: 

 

Starting With the RRR 
Your process might start by creating Receiving Reports before labeling.   No problem, the process is the same as 

described for Comply/Labeling:  Create a line item, click on [Edit] UIDs, and select the GFP items to ship.    Then when 

Labeling is run, the CLIN and its GFP UIIs will be there waiting for labels to be created. 
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Reparable Receiving Reports with Manual Custody Transfer 
Companies with lower volumes of GFP items may find it more cost effective to manually acknowledge custody of GFP 

items in the UID Registry web application.  This can be done while still using Comply/Shipper to submit the Reparable 

Receiving Report to WAWF.   

The process begins in Shipper with the 

Line Item Definition of a new shipment, 

like the one above.   Checking the GFP 

option changes the Shipping Advice Code 

to Government Furnished Property and 

the UID edit box to a GFP Items selector.   

Reparable items are kept separate from 

UID items that are sold by your company 

because they may lack the pedigree 

information that is association with the original sale, especially if 

sold by another company. 

Clicking on the [Edit] button above will bring up a list of the UIDs 

to be included on the current shipment.  The first time GFP 

items are added for a contract-order the user is asked for some 

information about the contract to be included in the WAWF 

RRR.   That is explained in the section on adding ACO / PCO 

Location Codes.  
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The Select Items to Ship screen includes items that were already added.  This was done by clicking on its [Receive GFP] 

button, which brings up a Receive Government Property Shipment screen, which is a scratch pad for collecting GFP 

UIDs.   We can add more UIDs to the shipment by clicking on [Add New Items].  This is discussed in the GFP Receiver 

Screen section. 

 

Note that the items just added are placed in Rcvd status.  When using UID Manager the next step would be to 

transmit those to the UID Registry to acknowledge custody of them.   Upon success their status would change to PPC 

(Property in Possession of Contractor), and be available to ship. 

To make the Rcvd items available for shipment, select them then use Set Status [Ship to Govt].  This changes their 

status to Shipping, meaning they are in the process of being shipped, but have not yet be shipped.   They will be 

counted in the number of items to be shipped, and included in the Reparable Receiving Report (RRR) to be generated. 

 

It is important that before submitting the RRR that the items are transferred to the custod of your company.  This is 

done in the UID Registry web application (https://wawf.eb.mil).   Failing to do this will cause the RRR to fail when 

submitted to WAWF. 
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Reparable RRs for Non-UID GFP 
Non UID-marked Items that have undergone maintenance, repair or overhaul (MRO) must be shipped on a Reparable 

Receiving Report (RRR) in accordance with DFARS Appendix F-104(b).   For MIL-Comply1 users creating these RRRs is 

just a matter of designating items as GFP and supplying a couple of additional location codes when the contract is first 

shipped.   

To ship GFP items simply mark the item as 

GFP when editing the Line Item Details.   

That changes the Shipping Advice Code to 

Government Furnished Property (E). 

Clicking on [Edit] or [Count] in the UIDs 

section will result in a message informing 

you that shipping UID-marked GFP 

requires such items to be formally taken 

into contractor custody in the UID Registry.  That process may be accomplished in Comply/UID-Manager.  Refer to the 

overview of the GFP/Reparables Process for details. 

ACO / PCO Location Codes 
One distinction between RRRs and standard RRs is the requirement for identifying the Contracting Office (ACO) and 

Buying Party (PCO) by their DODAAC.  This is done on the GFP Contract Information dialog that you can get to via 

Tools > GFP > Contract Data.  It has to be completed prior to WAWF submission, but only one time for all shipments 

on the contract. 

Note that the Buying Party is the generally the same 

as Issued By found in the shipment data, particularly 

if the shipment was populated by an import of the 

contract-order via EDI.   

Once a shipment is marked as having GFP items and 

includes the ACO and PCO location codes, creation 

of the Reparable RR is automatically done when 

MIL-Comply sends a Receiving Report to WAWF. 

 

                                                             
1 RRR generation for non-UID marked GFP requires MIL-Comply release 1.2.0200, or later. 
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General Information 

GFP Registration Status 
MIL-Comply uses a set of status points related to the WAWF and UIDReg processes to control the actions upon GFP 

items.        

Rcvd Received by Contractor  

AckCust Marked to Acknowledge Custody to the UID Registry 

CustAckd Custody Acknowledgement submitted to UID Registry 

CustError Error returned by UID Registry for Custody Request  

PPC Property in Possession of Contractor (acknowledged by UIDReg) 

OkToShip Ready for shipment 

Shipping Being prepared for shipment to Government via an WAWF RRR 

ShpdGovt Shipped to Government via an WAWF RRR 

ReqXfer Marked for transfer to a different contract (and/or vender) 

Xfered  Shipped to another contract via WAWF RRR 

 

 GFP items start as Rcvd and generally progress to either ShpdGovt or Xfered, depending on the disposition of the 

item.   There may be other states added as the software evolves. 

As of version 1.4.040, the PPC state is the trigger indicating that an item is ready to be shipped.  This state is achieved 

simply as a result of successful acknowledgement by UReg of change of custody to the contractor.  It does not reflect 

the state of the repair process.   

Users may choose to use OkToShip as a way of designating that the repair of the item has been completed.  Use of 

OkToShip as a trigger for Shipper and Labeling may become formally enforced (after appropriate configuration) in 

future versions.  For now, that will be left to customers to manage procedurally. 

The MIL-Comply design includes hooks for Work-In-Process (WIP) status keeping.  Management of items by their WIP 

status is a feature intended for future development. 
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Configuring UID Manager User 
The user of the Comply/UID-Manager must be configured 

prior to submitting any transactions to the UID Registry.   

Get to the UID Registrar Dialog via the Tools > Options 

menu command. 

The User ID is the same one as logged into the software. 

 

 

 

Sending Transactions to WAWF and UID 
Registry 

Comply/UID-Manager supports the sending and 

receiving of Direct UID Manager transactions via the 

Mil-Pac Value-Added Network (VAN) or a customer-

provided channel.   See the WAWF web site for 

information on setting up the later. 

VAN users will see this dialog pop up whenever a 

file is to be sent to the UID Registry.   Just click on 

[Connect], [Transmit] then [Done].  You may try this 

using the default DemoUser configuration, which 

sends transactions to a non-functional test user 

account. 

When configured for use of a customer-provided channel, outbound UID Registry transaction files are dropped into a 

designated folder and inbound responses picked up from a different one.  The customer is responsible for SFTP/SSH 

communications with WAWF. 
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Mil-Pac VAN Configuration 
Configuring the Comply/UID-Manager for Mil-Pac VAN 

use is described by instructions provided when the 

service is initiated.   Copies of those are available upon 

request.    

To configure for VAN use, first use the Tools > MP VAN 

Configuration menu command to bring up the EDI 

Communications dialog.   Ignore the (non-WAWF) part, 

as this is left-over from before the integration of the 

UID Registry under the WAWF umbrella. 

To use the Mil-Pac VAN, ensure that it is selected, and 

then click [VAN Setup].  

 

Enter the UCKey Filename provided by Mil-Pac when the service 

was initiated.  Leave it as DemoUser to test use of the VAN.   

Enter your CAGE Code where indicated.   You may leave the 

remainder of the controls in their default state ( as shown). 

 

 

 

 


